

    
      
          
            
  
Welcome to ViaLactea Visual Analytics’ documentation!

The ViaLactea Service is aimed at exploiting astrophysical surveys of the Galactic Plane to study the star formation process of the Milky Way.
The ViaLactea Visual Analytics (VLVA) tool combines different types of visualization to perform the analysis exploring the correlation between different data, for example 2D intensity images with 3D molecular spectral cubes.
All underlying data are managed by the ViaLactea Knowledge Base (VLKB). The VLKB includes 2D and 3D (velocity cubes) surveys, numerical model outputs, point-like and diffuse object catalogues and allows for retrival of all the available datasets as well as cutouts on the positional and/or velocity axis and some merging capabilities on adjacent datasets.

See ViaLactea Terms and Conditions and ViaLactea Privacy Policy.

For more details about the ViaLactea Visual Analytics tool and its aspects please refere to F. Vitello et al. 2018 PASP 130 084503 [https://iopscience.iop.org/article/10.1088/1538-3873/aac5d2].
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Introduction

The ViaLactea Software is developed in two main components: the ViaLactea Knowledge Base (following referred as VLKB) and the ViaLactea Visual Analytics (following referred as VLVA).

The VLKB documentation is available here [https://vlkb.readthedocs.io/].

VLVA is based on the VisIVO suite and offers a 2D and 3D visual analytics environment allowing the astronomers to easily conduct research activities interacting in a simple way with the VLKB and its services.

For more details about the ViaLactea Visual Analytics Tool and its aspects please refere to F. Vitello et al. 2018 PASP 130 084503 [https://iopscience.iop.org/article/10.1088/1538-3873/aac5d2].





            

          

      

      

    

  

    
      
          
            
  
Installation

VLVA is an open-source software available for macOS and Linux systems. The source code is available on GitHub [https://github.com/NEANIAS-Space/ViaLacteaVisualAnalytics].

To manually build and install VLVA (with its dependencies), follow the steps provided here [https://github.com/NEANIAS-Space/ViaLacteaVisualAnalytics/blob/master/INSTALL.md].

Pre-compiled DMG and Debian packages are available on the GitHub Releases page [https://github.com/NEANIAS-Space/ViaLacteaVisualAnalytics/releases].


Docker container

VLVA is also available as a Docker container. The container leverages Virtual Network Computing (VNC) and can be easily accessed through a browser.

To start a new container, use the following command:

$ docker run -it -e SIZEW=1920 -e SIZEH=1080 -e CDEPTH=24 -e SHARED=TRUE -e VNCPASS=vncpasswd -p 5901:5901 neaniasspace/vialacteavisualanalytics:latest





Then open a browser and go to http://localhost:5901/. The default password is “vncpasswd” (see the VNCPASS value defined in the Docker command).

Before starting VLVA change the scaling mode (Settings ‣ Scaling Mode ‣ Remote Resizing) and enable fullscreen (see Fig. 1).


[image: VNC settings]
Fig. 1 VNC settings



Now you can start VLVA using the icon on the desktop.


[image: ViaLactea Docker container]
Fig. 2 ViaLactea Docker container









            

          

      

      

    

  

    
      
          
            
  
Configuration

VLVA settings can be changed by selecting File ‣ Settings (ViaLacteaVisualAnalytics ‣ Preferences on macOS) in the menu bar of the main window.


[image: Setting window]
Fig. 3 Settings window



IDL (or GDL) is needed to perform SED Fitting operations on the local machine. Typically in macOS the binary executable path is /Applications/exelis/idl/bin/idl; in Linux is /usr/local/bin/idl).

The Tile path is required to show the Galactic Plane view on the main window and it is the openlayers.html absolute path. It can be either local (on the local computer) or remote. By default a URL of the Tile path is provided and enabled.

The glyph max value is used for the 3D visualization of compact sources. The default (and maximum) value for this option is 2147483647.

It is possible to select which VLKB instance the tool will connect to. Currently there are three active VLKB instances: the public access hosted at INAF-OATS, the private access also hosted at INAF-OATS, and the NEANIAS instance. By default, the public instance is selected.
The private and the NEANIAS instances are restricted to authenticated users.
The private instance requires an username and a password.
The NEANIAS instance, instead, requires the user to login via the NEANIAS SSO.

Users who want to use the NEANIAS instance must request access [https://docs.neanias.eu/projects/s1-service/en/latest/services/vialactea.html#service-access] to the service through the NEANIAS Service Management System.





            

          

      

      

    

  

    
      
          
            
  
Main Window

The Main Window shows an interactive view of the galactic plane (longitude from -180° to +180° and latitude from -2° to 2°). This view can be used to perform a visual selection of the region of interest.

The selection of the region can be carried out choosing a point on the map and then specifying the radius of selection, or picking up a rectangular region.

It is also possible to specify the surveys and wavelengths for the VLKB query using the checkboxes on the right panel.


[image: Main window]
Fig. 4 Main window interface



Clicking on the Query button, VLVA sends the query to the VLKB and then opens on a separate window the FITS image containing selected region, in the chosen survey and wavelength, that is used as starting point for performing the visual analytic operations.

VLVA allows to load a FITS file image that is locally stored on the user’s computer by clicking on the Local Image button.

Similarly, the Local DC button allows to load and visualize a velocity datacube FITS file that is already stored on a local disk. When loading a datacube, VLVA will also compute the zeroth moment map which will be visualized as a 2D image layer.
The VLKB search functionality is also extended to imported files.

The Select button under the 3D section allows to specify the range of coordinates on which to perform a 3D visualization of compact sources on the galactic plane (3D visualization of compact sources).





            

          

      

      

    

  

    
      
          
            
  
Image visualization

Once the selected region has been downloaded or locally loaded from the Main Window, the 2D visualization window is shown.

By default, a grey color palette is used to visualize the image. The color palette can be changed using a predefined one embedded in the tool, for each of them is possible to select whether to use linear or logarithmic scale.

The image can be zoomed with the mouse wheel and panned dragging it when the SHIFT button is pressed.

Contrast and saturation of the image can be changed by holding the left mouse button and moving on the image. The bottom of the window shows the pixel value pointed by the mouse cursor, along with the coordinates expressed as pixel (X, Y), galactic (GLON, GLAT), fk5 (RA, DEC) and ecliptic (RA, DEC) as shown in Fig. 5.


[image: Coords]
Fig. 5 Information of the pixel pointed by the mouse cursor



On the top-right panel there is a list (following referred as VLKB inventory) of images and datacubes available in the ViaLactea Knowledge Base related to the visualized region. A single click on a inventory item shows a footprint on top of the visualized image to display the area covered by the item (Fig. 6). The elements with a full overlap with the image can be recognized by the green background.


[image: Footprint]
Fig. 6 Footprint visualization



Furthermore, the following operations can be carried out:



	Adding a new layer image


	Compact sources visualization


	SED Analysis






	Filaments visualization







Adding a new layer image

A new layer image can be added by double-clicking a Continuum item on the VLKB inventory, or by loading a local file from the Main Window. In the latter case the image must be compatible, i.e. there must be an overlap among the images.

New layers are aligned (position, scaling pixel size, rotation) to the “image base” using the information contained in their header.

Each layer is listed in the bottom-right panel (see Fig. 7). This panel is organized as a reverse stack: the user eye is on the bottom of this stack and sees all activated layers by transparency. It is possible to move a layer up or down in the stack to change the visualization order.

The checkbox on the left of each row can activate or deactivate the visualization of the relative layer. The opacity, the color palette and the scale of each layer can be modified in the Layer setting panel located in the upper part of the window.


[image: Layers]
Fig. 7 Visualization of several layers






Compact sources visualization

VLVA allows to visualize compact sources overlapped to the fits image.

To query the VLKB for compact sources, click on the Compact Source button (or use the keyboard shortcut cmd ⌘ + R on macOS system or ctrl + R on Linux) and make a rectangular selection of the region of interest on the visualized image.

VLVA extracts the coordinates from the selection and shows a window to query the VLKB (see Fig. 8).

By default, VLVA queries the VLKB to obtain sources from the bandmerged table. It is possible to download and visualize the compact sources of just one band by selecting the desired one from a dropdown list Table in the panel.


[image: Query Compact Sources]
Fig. 8 Compact Source query window



The Query button sends the query to the VLKB and if there are any results, VLVA will automatically displays the compact sources on top of the image (see Fig. 9).


[image: Compact Sources]
Fig. 9 Visualization of compact sources retrieved from the VLKB



The compact sources are shown in different colors on the image depending on the relative wavelength. Similarly to the layers management, by using the checkbox it is possible to select which compact sources to display. It is also possible to change the color used to show the sources in the visualization by double-clicking on the colored rectangle of each row.


SED Analysis

To perform SED analysis, from the menu bar go to Window ‣ Select (or use the keyboard shortcut cmd ⌘ + S on macOS system or ctrl + S on Linux), select one or more of the visualized clumps and click on the SED button. Fit operations are performed in a transparent way for the user locally using integrated IDL routines or remotely. In the latter case, a Java JRE is required to communicate with the remote service.

There are three different kinds of fitting operations available, one for the fit with the theoretical models and two for the analytical fit. Fitting operations are performed from the menu bar selecting Action ‣ Fit ‣ Theoretical model or Action ‣ Fit ‣ Grey-body. It is also possible to perform the fitting operations by clicking on the buttons on the right panel (see Fig. 10).


[image: SED]
Fig. 10 SED plot



In case the SED presents multiple associations, it is possible to sum the fluxes of counterparts obtaining the SED with a cumulative flux. This operation is done by checking Collapse All from the right panel.

If the Multi Select visualization mode is activated, the fit operation is performed only on the selected nodes on the graph.

The bottom panel in this window shows either the output logs or the results of the SED fitting operation. A list of fits appears once a new fit is performed. Each one can be checked to show it on the plot. The Clear All button removes all the plotted fits (see Fig. 11).


[image: SED plot]
Fig. 11 SED plot: in blue the theoretical fit performed on the selected SED








Filaments visualization

Similarly to the compact sources query, filament structures can be visualized by selecting the Filaments button on top of the window and making a rectangular selection.

The filaments are displayed with contour and spine on top of the image as shown in Fig. 12. Their colors and visualization can be changed in the same way as the compact sources.


[image: Filaments]
Fig. 12 Filaments visualization









            

          

      

      

    

  

    
      
          
            
  
Datacube visualization

When the user selects a datacube from the VLKB inventory, or when they load a datacube from their local disk, VLVA opens a new window to visualize datacube.


[image: DC]
Fig. 13 Datacube visualization



The 3D datacube visualization (left panel) can be controlled by the mouse movements. The camera can be reset to pre-defined views using the Camera Menu, e.g. Camera ‣ Front will place the camera in front of the datacube.

The 3D visualization can be zoomed with the mouse wheel and panned holding the SHIFT key.

The datacube visualization is rendered using isosurfaces algorithm with the threshold specified by the Threshold slider located in the top panel.

The right panel shows a slice of the velocity datacube. The slice is selected using the Cutting Plane slider.

Any changes to these sliders will update the visualization in real-time.

Contrast and saturation of the visualized slice can be changed by holding the left mouse button and moving the cursor on the image. The bottom of the window shows the pixel value pointed by the mouse cursor, along with the coordinates expressed as pixel (X, Y), galactic (GLON, GLAT), fk5 (RA, DEC) and ecliptic (RA, DEC).


Isocontours

If the Contours checkbox is enabled, the isocontours are displayed on top of the selected slice as shown in Fig. 14. The contours are also reported on the 2D map image. Contours settings can be modified by changing the Level, the Upper bound and Lower bound values.


[image: Contours]
Fig. 14 Contours visualization






Moment maps

VLVA allows to compute the zeroth and the first moment maps and visualize them as a new layer on top of the 2D image currently open. From the datacube window, the zeroth moment map is computed by clicking on the menu Moment ‣ Calculate order 0. The results is shown in Fig. 15.


[image: Moment]
Fig. 15 Contours and zeroth moment map visualization on the 2D image









            

          

      

      

    

  

    
      
          
            
  
3D visualization of compact sources

The 3D visualization can be performed by clicking on the Select button of the Main Window (see Fig. 4) and then typing the region bounds (in degrees) of the area of interest.


[image: 3D sources visualization]
Fig. 16 3D Visualization of sources on galactic plane



The 3D view is interactive and the camera position can be moved with mouse operations. The color palette can be mapped to a pre-defined field (e.g. temperature) in the Lut box in the top panel. The scale and range values can also be changed.

The shape and the scaling factor of each source can be modified in the Glyph panel. The points are scaled based on the selected field (e.g. mass). The maximum number of glyphs visualized is set in the Settings (Fig. 3).





            

          

      

      

    

  

    
      
          
            
  
Local session management

VLVA allows to save the work session and restore it later.
The session is a folder containing a JSON configuration file and all the files required to resume the visual analysis operations.


Saving a session

The session includes:


	the image layers and their settings (color palette, scale, transparency level, whether or not they are visualized);


	compact sources (color, whether or not they are visualized);


	filaments (color, whether or not they are visualized);


	datacube windows and their settings (threshold, cutting plane and contours values).




To save the session, from the 2D visualization window go to menu File ‣ Save session and then select an empty folder on the local disk. If you try to save a previously loaded or already saved session, the tool will ask whether to overwrite the current session or save it in a separate folder.




Loading a session

To load a session, from the Main Window go to menu File ‣ Load session and then select the session.json file inside a session folder. VLVA will restore the status of the work session as it was saved.
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ViaLactea Privacy Policy


1.       Introduction

The software service ViaLactea (Service) is operated by INAF (Provider). Elements of the Service (Service Elements), be it technology, algorithms, documents, data, other services, processes and other resources, are also provided by third-parties (Other Providers).

INAF is a research institute in astronomy and astrophysics with full name Istituto Nazionale di Astrofisica est. 1999 in Italy, funding and operating twenty separate research facilities, which employ scientists, engineers and technical staff. INAF headquarters are located in Viale del Parco Mellini n84 00136, Rome, Italy.

Specific Service Elements (the ViaLactea Visual Analytic and the ViaLactea Knowlegde Base) have been produced and maintained with the co-funding of the European Commission, under NEANIAS project [GA 863448]. Service Elements are the sole responsibility of the Provider. Nothing in the Service shall be considered as reflecting the views of the European Commission.

Protecting your personal data is very important to us. Our Privacy Policy is intended to help you understand why we collect your personal information and how we use it. It provides detailed information about when and why we collect your personal information, how we use and process it, how long we keep it, and finally, under what terms we can share it with others.




2.       Scope

This Privacy Policy applies to all of you who access and use our Service.

This policy applies solely to personal data and information that the Service collects through its usage or through any electronic communication of the User with the Provider, as indicated on the Service (herein referred to as Personal Data).

We may also collect information from you in other ways, including information collected during technical support contacts. If we provide a separate or supplemental notice when we collect personal data from you, that notice will control to the extent of any conflict.

It does not apply to any website of third-party services that the Service may link to. The Service does not endorse, nor is responsible for the content of these websites or third-party services, or their policies or practices.




3.       Information Collected

The Service manages different types of data, all in compliance with the current European legislation on Data Protection. Any Data concerning the User is collected to allow the Provider to provide the services.




A.   Required Data

Personal Data

The provision of the Service requires that certain pieces of personally identifiable information are processed. Personal data of yours we process:


name

email address







Registration information

The Service may utilize services of unaffiliated third-party providers for providing additional features. Those may require that these providers have access to Personal Data such as name, affiliation and email address. These vendors may also provide the Service with this information, so that the Service can keep track of Users linking to those third-party services. In this case, the information that the User may provide as part of this registration will be subject to both this Privacy Policy and the corresponding statement of the third-party Service.




Operational data

Services and infrastructure management software automatically gather general information from Users, such as IP address, computer type, screen resolution, OS version, domain name, location, date and time of the visit, page(s) visited, time spent on a page, origin from where the User may come into the service, requests to the Via Lactea backend search, cutout and merge services for logging and accounting purposes. etc. Some of this information is provided directly by the User’s client software (e.g. the ViaLactea Visual Analytics) while the remainder is obtained through tracking technologies.




4.       Children

The Service is not intended for children.

The Service does not collect knowingly any Personal Data from or about children.




5.       Use of Personal Data

The Personal Data required by our Service are processed for the following purposes:


Fulfilment of requests: The Service uses Personal Data to deal with inquiries, contact the user (via the service management system) and deliver notifications.

Service operation: The Service uses JWT tokens to identify users in order to adapt / grant its capabilities, grant access to specific Service areas, grant access to relevant information, filter content etc.

Statistical analysis: Aggregated data about Service usage (which do not identify a specific user), such as the number of users who have performed certain data survey searches on the Service, or how long users are spending on a particular session, are used to feed statistics as to the use of the Service.

Internal business purposes: The Provider uses the collected information for internal business purposes, such as for audits or to track service feature use and behaviour, justification of resource usage, extraction of operational KPIs etc.

Service and products design: Aggregated and Personal Data are used by the Provider so that improvements, adjustments and refinements are performed, as well as new Services and Products are designed to address general or user-specific needs.

Displaying User information: Data concerning the User are presented by the service to allow Users to identify ownership, provenance and allocation of various resources.




Our Service guarantees that your personal data will not be used for purposes other than those set forth in this policy, without prior notice and where your approval is required.

The Data processing is carried out using computers and/or IT enabled tools, following organizational procedures and modes strictly related to the purposes indicated.

The Provider considers User Personal Data as an asset that is not for sale and will never sell User Personal Data to any third-party.




6.       Recipients of personal data

Access to personal data and transaction information is only authorized by employees, affiliates and third parties who process the above data at the Providers discretion and only when and to the extent necessary for the above purposes. Personal data may only be transmitted, for the purposes of the above processing, to specific recipients who are employees, and generally affiliates as well as third parties affiliated with the Provider. In addition, the Provider may, without prior notice, disclose your information to the competent judicial and/or administrative authorities to the extent required by applicable laws and regulations, or by judicial decision and/or administrative act.

The service will explicitly provide data on user actions to (a) the NEANIAS Log Aggregation service, for combined troubleshooting of its operation and optimising use of resources provided to the service and (b) the NEANIAS Accounting Service, in order to summarize information on the use of resources by individual users, for the purposes of sizing its usage and, if needed, limiting or restricting access to its operations. Data provided to the aforementioned services shall not include user credentials or any such other user secret.

Additionally, the service will provide, either directly or via data collected by the NEANIAS Accounting Service, aggregate anonymized data for the calculation of Key Performance Indicators (KPIs) on its operation and performance. No sensitive data shall be included in those service transactions.

The Provider makes every effort to control and evaluate when selecting its affiliates to whom it transmits the personal data of those concerned. There is a written agreement between the Provider and any third party, according to which the processing of personal data is carried out under the control of the Provider and only on its order and is subject to the same data protection policy.




7.       Interaction with Identity Providers, Social Networks and External Platforms

The Service allows the User to interact with Identity Providers (herein referred to as third-party Platform), directly from the user interface of the Service. The information acquired by the Service through this interaction is always subject to the User’s privacy settings related to the third-party Platform.




8.       Data retention time

The time period for storing data is decided on the basis of the following specific criteria, as appropriate:


Where processing is required by provisions of the applicable legal framework, your personal data will be stored for as long as the relevant provisions require.

When processed on a contract basis, your personal data is stored for as long as necessary for the performance of the contract and for the foundation, exercise, and/or support of legal claims under the contract.

For other purposes, your personal information is kept until your consent is withdrawn. This can be done at any time. Withdrawal of consent does not affect the legality of the consent-based treatment during the period prior to its withdrawal. You can revoke your consent at any time by selecting the link provided in the emails we send to you.







9.       Your Rights and Choices

As defined in the Regulation (EU) 2016/679 (General Data Protection Regulation), you (as the data subject) have the following Rights:


Right to have access to the Personal Data that is held about you by the Provider - what data we have collected, for what purpose, how it is processed and how long it is stored (article 15).

Right to rectification (article 16). You have the right to obtain from the Provider the rectification of inaccurate personal data and to have incomplete personal data completed.

Right to erasure (right to be forgotten) (article 17). You have the right to obtain from the Provider the erasure of personal data concerning you.

Right to restriction of processing (article 18). You shall have the right to obtain from the Provider restriction of processing where one of the following applies: (a) the accuracy of the personal data is contested, (b) the processing is unlawful, or (c) the Provider no longer needs the personal data for the purposes of the processing.

Notification obligation regarding rectification or erasure of personal data or restriction of processing by the Provider (article 19). The Provider will communicate any rectification or erasure of personal data or restriction of processing carried out to each recipient to whom the personal data have been disclosed, unless this proves impossible or involves disproportionate effort. The Provider shall inform you about those recipients if you request it.

Right to data portability (article 20). You have the right to receive the personal data concerning you, in a structured, commonly used and machine-readable format and have the right to transmit those data to another Party without hindrance from the Provider.

Right to object (article 21). You have the right to object to processing of your personal data. The Provider shall no longer process the personal data unless the Provider demonstrates compelling legitimate grounds for the processing which override the interests, rights and freedoms of the data subject or for the establishment, exercise or defence of legal claims.




Before we are able to provide you with any information or correct any inaccuracies, we may ask you to verify your identity and/or provide other details to help us respond to your request.

The Provider reserves the right not to respond to requests generated through third-party applications or automated processes without direct validation of the requests by data subjects using the resources provided by the Service for the exercise of these rights as described in this Policy.




10.  Data security

The Provider takes care to guard the security of your personal data. We apply appropriate physical, technical and organizational measures that are reasonably designed to protect personal data against accidental or unlawful destruction, loss, alteration, unauthorized disclosure or access, and against all other unlawful forms of processing. We maintain a security program that is proportionate to the risks associated with the processing.




11.  Location of Personal Data Storage

The Service is provided via its project managed instance, whose servers are located in Italy and Greece and provided by a multitude of Providers: INAF Italian center for Astronomical Archives - IA2 (IT), NKUA Data Center (GR), CITE Communication & Information Technologies Experts SA (GR), GARR - Gruppo per l’Armonizzazione delle Reti della Ricerca (IT).

The Data is processed at the infrastructures of the aforementioned providers and in any other places where the parties involved in the processing are located. For further information, please contact the Provider.




12.  Disclosure of Personal Data to Third-Parties

The Provider processes Personal Data in a proper manner and takes appropriate security measures to prevent unauthorized access, disclosure, modification, or destruction of them.

In addition to the Provider, in some cases, the Data may be accessible to certain types of persons in charge, involved with the operation of the Service (administration, legal, system administration) or external parties (such as third-party technical service providers, mail carriers, hosting providers, IT companies, communications agencies) appointed, if necessary, as Data Processors by the Provider. Specifically:


NKUA, CITE and GARR Providers of the NEANIAS AAI, Logging and Accounting services,

Google and Microsoft Identity Providers for Authentication.




The updated list of these parties may be requested from the Provider at any time.

As the Service relies on a list of distributed services, in the process of supporting a user request we might have to share Personal Data with Other Providers.




13.  Transfer of Data outside EU

We store personal data on servers located in the European Economic Area (EEA). Each organization is required to safeguard personal data in accordance with our contractual obligations and data protection legislation.




14.  Law enforcement - compliance

The Provider may use or disclose Personal Data to any third-party (a) if required to do so by law; (b) to comply with legal processes or respond to requests from governmental or public authorities; (c) to prevent, investigate, detect, or prosecute criminal offenses or attacks on the technical integrity of the Service or network; (d) to enforce Terms and Conditions; or (e) to protect the rights, privacy, property, business, or safety of the Provider, its business partners, employees, members, Service Users, or the public. Unless prohibited by applicable law, the Provider shall inform the User if a third-party requests access to Personal Data about the User.




15.  Policy modification

This privacy policy may be modified. We will make sure to keep you informed of any changes, but in any event we invite you to visit our website regularly, where the most up-to-date Privacy Policy will be posted.




16.  Exercise of your Rights, Inquiries, Objections, Complaints

For exercising your rights, or for any questions, comments, objections or complaints, regarding this Privacy Policy or privacy, security or data protection practices applied, please contact the Provider by email via its designated Data Protection Officer rpd@inaf.it.

We handle your requests with the utmost care to ensure that your rights are protected. For any requests that may require assumption or disclosure of Personal Data, the User will have to demonstrate legitimate grounds for making the respective requests, as well as provide sufficient evident for the identity of the User.

In some cases we may not be able to process your request directly. However, in any event we will inform you of the progress of your request within one month of the submission of your original request.

You always have the right to complain to the Italian Data Protection Authority (https://www.garanteprivacy.it/home_en), if you are concerned about how we have processed your personal data.

Effective Date: 24 May 2021







            

          

      

      

    

  

    
      
          
            
  
ViaLactea Terms and Conditions

Last revised on 24 May, 2021


Disclaimer

Welcome to “ViaLactea”. ViaLactea (hereinafter referred to as “Service”) is provided as a service to its users according to these Terms and Conditions (the “Terms and Conditions”). Please carefully read and understand these Terms and Conditions before using this Service. By using this Service, you accept and agree to be bound and abide by the following Terms and Conditions. If you do not agree with these Terms and Conditions, you shall not access or use this Service.

This Service is operated by INAF (“Provider”) on resources provided by INAF, other Providers and cloud platforms. Elements of the Service (“Service Elements”), be it technology, algorithms, documents, data, other services, processes and other resources, may have been or may be currently provided the Provider or by third parties (“Other Providers”). The Provider and Other Providers shall be collectively called “Providers”.

Specific Service Elements have been produced and maintained with the co-funding of the European Commission. Service Elements are the sole responsibility of the respective Providers. Nothing in the Service shall be considered as reflecting the views of the European Commission.

The Service itself, as well as any data or information or other element that may become accessible through the Service, is provided on an “as is” and “as available” basis. Users of the Service assume their own responsibility for assessing the relevance, accuracy and suitability of the Service and any Service Element they may use. The Provider makes effort to ensure, but does not guarantee, the accuracy, completeness or authenticity of the processes, data and information managed and provided by the Service.

The Provider reserves the right to change, edit, or delete any documents, information, or other content related to the Service or these Terms and Conditions from time to time without notice and at its sole discretion. All changes are effective immediately when posted and apply to all access to, and use of, this Service thereafter. Every time you wish to use the Service, please review these Terms and Conditions to ensure that you understand the terms that may apply to you at that time.

The Provider reserves the right to alter, limit or discontinue any part of this Service at its discretion. The same applies for Other Providers, unless otherwise explicitly declared. Under no circumstances shall any of the Providers be held responsible for any loss, damage, liability, or expense suffered that is claimed to result from the use, data or information managed by the Service and Service Elements, including without limitation, any fault, error, omission, interruption, or delay.

Hyperlinks to external to the Service resources do not imply any official endorsement of, or responsibility on the side of Providers for the opinions, ideas, content, or products presented at these locations. Neither do Providers guarantee the validity of the information provided. The sole purpose of links to external resources is to indicate further information available on related topics. The information is provided on the basis that Users of the Service assume their own responsibility for assessing its relevance, accuracy, and suitability for application.

The Provider does not claim any ownership and does not undertake any responsibility on data, information, content, comments, code, processes, or other elements uploaded or embedded into the Service by other Users, if such facilities are offered by the Service. The User is responsible for protecting his/her assets and personal data from any such Element present in the Service.

To the best of Provider’s intention reasonable security measures consistent with practice applicable to the domain of Service operation are applied to protect sensitive information under its control against loss, misuse, and alteration. However, the Provider cannot guarantee the security of physical locations, the hardware, software and networks, the means by which sensitive information is handled and transmitted between computers and applications, or any sensitive information that may be received through or in connection with the Service. The Provider excludes, in so far as allowed, any warranties implied by law.




Copyright

The Provider and Other Providers reserve all rights of the elements they provide.

The functionalities, data and information made available through this Service are available under terms described in the metadata or other information describing or accompanying the Service.




License

Users granted access via the process established by the Provider, are licensed to use of the Service under the terms of the license.

The Provider grants license to use this Service freely to its Users, under the terms of this document. Access to the Service though may be limited due to availability of underlying resources. The Provider may revoke this License or change its terms at its own discretion without prior notice to Service Users.  It is to the best of Provider’s intentions to try to timely inform Users accessing the Service before such an action, however this may not be guaranteed.

Service Users are required to make a clear reference to the Service use for any products or services that may be created on top of results or use of this Service.

Products or derivatives produced and made available through this Service are licensed under the license declared by their respective owners and not the Provider or Other Providers, except where otherwise explicitly noted. The Providers are not held responsible for the license terms of those elements. See section “How to Cite or Acknowledge Service”.

At any time and without prior notice, the Provider may limit access to the Service to any person, geographic area, or jurisdiction that the Provider chooses, at Provider’s sole discretion.




Use of Service

The Provider does not represent or warrant that the Service is appropriate or available for use in any particular jurisdiction. Users of the Service do so on their own initiative and at their own risk, and are responsible for complying with all local laws, rules, and regulations that apply to them.

By using the Service, the User agrees to all terms of the “Terms and Conditions” document as this may be formed and applies at any point in time.

By using the Service, the User agrees that he/she is entitled to use the Service under the conditions presented to the Provider upon request for access to the Service or as those may be presented explicitly in the section “License” of the document.

Under no circumstances shall a User use the Service for conducting any malicious activity, which may indicatively and not exclusively refer to: access to or exposure of personal or confidential data of other parties or Users, delivery of malicious code to other Service Users or systems, intentional overloading of Service or Providers’ resources, any action causing denial-of-service for the Service or any third party service or resource, impersonation of Provider, its personnel or any Service Users, inflict impact on financial or social status of Provider, its personnel or Service Users etc.

The User commits to use resources provided by the Service, and the Service itself, as intended by the Service, for no other reason and by no other means than the ones intended by the Service. In case of uncertainty of the validity of a use, the User commits to request further information from the Provider before performing such a use.

If the Service offers such facilities, the User under no circumstances shall upload to the Service any data, information, comments, code, processes, or other Elements that he/she does not have the license to use under the Service, or that may be inappropriate in any way or may harm other Users or the Service.

The User commits to promptly inform the Provider about any vulnerabilities or issues he/she has identified or has been informed about, during the use of the Service.

The User commits to promptly inform the Provider of any malicious, or otherwise inappropriate data, information, comments, code, processes, or other element made available on the Service that he/she becomes aware of.

The User is responsible for managing his/her own credentials and the security of his/her account. The User shall notify the Provider as soon as he/she becomes aware of unauthorized use of his/her account.

The Provider reserves the right to take any legal action upon Service misuse to protect the interests of itself as well as of its Users and Other Providers. The Provider may proactively terminate a User account and associated access to the Service without any warning, to prevent the Service, its resources or other Users from suspected erroneous or malicious actions from the User or anyone impersonating the User.

The Provider may alter the “Terms and Conditions” of the Service, without prior notice. It is to the best of Provider’s intentions to notify the User for essential changes in this document or documents that may be addressed by it, however this may not be guaranteed.

The User will be held liable for compensating the Provider if any claims to the Provider rise from breaching any term of this “Terms and Conditions” document by the User. Such compensation may include and is not limited to penalties that may apply, third party damage claims, Provider ethical and financial damage, Provider effort and Legal expenses and any other related costs.




Acknowledge of Service

Any work produced by making use of assets made available by the Service should acknowledge the support received and give credit to it. Please include the following reference:


“This work has been produced with the support of  ‘ViaLactea’ provided by INAF (www.inaf.it) with the co-funding of the European Commission, under NEANIAS project [GA 863448]”




For citing other elements that access to is granted via the Service, please refer to their respective owners for citation information.




Effectiveness

If any part of this “Terms and Conditions” document is ineffective for any reason (e.g. unlawful or overridden by other document), the rest of the agreement remains valid excluding the ineffective part.

This “Terms and Conditions” document is between the Provider and the User and under no circumstances may it be transferred to any third party by the User.

Neither the User nor the Provider may be held liable for any breach of the terms of this License occurring due to conditions outside their respective reasonable control (“Force Majeure”).

The Provider may refrain from exercising rights of this “Terms and Conditions” document for any reason the Provider may choose, at any situation and point in time. This shall not be assumed as a withdrawal from the right to exercise its respective rights in the future for the same, similar or different cases.




Your Agreement to the Terms

Your access or use of the Service or/and any resource provided by or accessed through it, in any way signifies that you have read, understand and agree to be bound by the terms of this document.
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